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Chapter 1 PC Basics  

About This Chapter 
This chapter describes computer basics: the basic knowledge necessary for using hardware and software of 

computer and network. 
The most important attitude you should maintain when you learn to use a computer is “practice makes 

perfect.” Even if you do not learn what is described here, you can use a computer in some way or intuitively; 
however, there are some key points you should know in order to use a computer efficiently, effectively, and 
safely. In this chapter discussion focuses on these key points. 

Many of you may already have a computer at home or a PC of your own. This chapter provides you with an 
answer to the frequently asked question: “What kind of PC should I purchase?” Some people may disagree with 
the decision to include such a section in this book, but we guarantee that squarely tackling the issue of how to 
select a PC will dramatically improve your knowledge of it. 

PCs in the university have basic security protection installed, but you have to protect your own PC. We are no 
longer surprised by news of information disclosures. Therefore, this chapter also discusses basic security. 

Whether we are talking about its hardware or software, a computer is an integration of technologies. 
Computers are one of the most versatile tools human beings have ever invented. Although we cannot describe 
computers in depth here, we still need to have a rough idea about their principles in order to use them. 

In other words, this book contains only a brief description, so if you want to know about computers in more 
detail, you need to read the bibliography. 

You can also find basic troubleshooting tips at the end of this chapter. Since problems vary from case to case, 
it is difficult to provide specific solutions. Therefore, this chapter can only gives you general ideas. When your 
computer is not working properly, you may feel hopeless. But remember that troubleshooting also provides you 
with an opportunity to improve your literacy because troubleshooting requires all-round computer skills. This 
chapter gives you the approach to build up such skills. 
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1.1 PCs 
The word “PC” stands for personal computer. There are many different kinds of computers, and some of them 

are too expensive or too big for individuals to own. You can think of PCs as being mainly for use by individuals. 
Although PCs these days are mainstream devices, since computers used to be very expensive, in earlier days it 
was common practice for several people to share one computer. A high-performance PC is sometimes called a 
workstation, but actually there is no clear distinction between a PC and a workstation. 

“Computer” literally means a computing machine, and its original purpose was to be used for calculation. 
However, if we consider that video game consoles are also computers, computer have become so popular that 
they are practically household appliances nowadays. You no longer need specialized knowledge to use one. 

Many readers must have used a PC before. This section describes common-sense knowledge of PCs. Even if 
you are already familiar with this kind of material, do not skip this section. Read through it once to refresh your 
knowledge. 

1.1.1 Hardware and Software 

The components of a computer can be roughly classified into hardware and software. Hardware is a collective 
name for the physical parts of a computer which we can actually see and touch. Meanwhile the term “software” 
has been coined through the calling of the non-hardware parts of a computer “soft” as opposed to “hard” as in 
hardware. Hardware refers to tangible devices, while software refers to intangible information. 

The distinction between hardware and software is not limited to computers. For example, a CD consists of a 
tangible disk and intangible information (music) recorded on it. Television and radio involve broadcasting 
equipment and receiving sets as tangible hardware and programs as intangible software. Television and radio 
programs and music are often described as “soft” in Japan, and what is described by this term is essentially the 
same thing as computer software. 

What is important here is that regardless of which hardware you have, it cannot do much by itself. Hardware is 
useful only with software. The opposite is also true: software alone is worthless. 

We assume that you already have computer hardware at hand. Since you are not going to assemble a computer 
by yourself here, most of descriptions in this book are about software. Just remember, though, software does not 
work without hardware. 

1.1.2 Basic Configuration of a PC and its Peripheral Devices 

Figure 1.1 “PC components” (p. 3)1 shows the main components of a PC. 
The following gives the names of the numbered parts and devices respectively. 
 

1. Display 

2. Motherboard 

3. CPU (Microprocessor) 

4. Main storage unit (Random Access Memory or RAM) 

	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 
1 Source: Gustavb, Wikimedia Commons. http://en.wikipedia.org/wiki/Image:Personal_computer, _exploded_5.svg. 

This file is licensed under a Creative Commons Attribution 2.5 License. 
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Figure 1.1: PC components 

(Source: Wikimedia Commons) 

5. Expansion card 

6. Power equipment 

7. Optical disk drive (CD, DVD, etc.) 

8. Hard disk drive (HDD) 

9. Keyboard 

10. Mouse 
 

It may be easier for you to understand computers if you think about them in terms of its three functions: input, 
processing, and output. 

A computer processes information and has three devices for each of these three functions: a device for the 
input of information into the computer, a device to process information within the computer, and a device to 
output the results of processing. For example, a keyboard and a mouse are used for data input; a display and a 
printer are used for data output; and memory, a hard disk, and an optical disk drive are used for both data input 
and output. Actual numerical computation is performed by a CPU. 

CPU stands for Central Processing Unit and a CPU can be called the brain of a computer. A CPU is a device 
to perform computations, and the computing speed of the CPU largely determines the operating speed of a 
computer2. 

	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 
2 Even if your CPU is very fast, the operating speed of the computer depends on the operating speeds of other parts, too. So it is important for computers to be 
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The main storage unit (RAM) is included for data storage. The original data for CPU to process and the 
computation results are basically accumulated in RAM. However, RAM is also called volatile memory; that is, 
RAM needs regular power supply to retain its memory. The memory will be lost whenever the power of the PC 
is turned off. Because of this volatility, hard disk drives, optical disk drives, and USB flash drives are used as 
auxiliary storage devices for the permanent saving of data3. 

As we have seen, a PC consists of various parts. These parts are standardized4 down to the very screws, 
enabling you to build your own computer using the parts you like, or add memory to your computer to improve 
its performance, or replace some of the parts by more powerful ones for specific use (for example, installing a 
high-performance graphics card for game playing). 

All of these parts are connected to a circuit board called a motherboard. A set of LSIs called a chipset is 
mounted on the motherboard, and this chipset controls the parts that are connected to the motherboard, such as 
the CPU and memory. Earlier we mentioned that the CPU is the brain of a computer. But only with the 
motherboard, equivalent to the nervous system in the human body, can each part fulfill its function. 

There are many different types of motherboards, and on each motherboard a different variety of functions are 
installed. For example, all recent motherboards include network connection as a standard function, but old 
motherboards in general do not. If your computer motherboard does not come with this functionality, you can 
add a network expansion card. There are a wide variety of expansion cards. The most popular expansion card is a 
video card which is used to connect a PC and a display. 

1.1.3 Software 

Software controls hardware, as described in the preceding section 1.1.2 “Basic Configuration of a PC and its 
Peripheral Devices” (p. 2). As mentioned earlier, computer hardware alone does nothing. For example, in order 
to display the character A on the screen when the A key is pressed, it requires software processing to detect that 
the A key has been pressed and to display the letter A on the screen. 

As has been described above, software gives processing instructions to hardware.  
Software in a broad sense also includes data, such as text, music, and images5. Such data is also important. 

The central theme of this book is how to efficiently and effectively create and manage data resulting from 
scientific activities, using a computer. 

The key point about both software and data is that they must be created by humans. A computer does not 
create software automatically. 

Consequently, every piece of software is a copyrighted work, and therefore you cannot use it freely unless it is 
your creation. Here, to “use it freely” means to create a copy and install it in your computer or give a copy to 
your friends. Some software can be used freely without cost. The ways in which you are permitted to use 
software are usually prescribed in its license, so check the license carefully before using any software. Chapter 6, 
“Basics of Report and Paper Writing” (p. 69), explains copyright in detail. 

Since software is created by humans, any absurd action that a computer does is a result of somebody giving an 
instruction to the computer to perform the absurd action.  

	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 
designed according to their intended use. 

3 Since information cannot be stored forever, you need to take care. 
4 In the case of a screw, subjects of standardization include its type (form) and the size of its diameter. There are two types of standards: de facto (actual) 

standards accept the specification of products, which have survived the competition in the marketplace, as standard; and de jure (legal) standards are set up 
by public agencies, such as the government. 

5 Data is a language in a broad sense, and software is in that sense a type of data. In this book, “data” refers to the information processed or to be processed by 
software (text, numeric values, etc.). 
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Whether writing created with a computer is beautiful or poor are mere reflections of the ability of the writer. 
There is often a discrepancy between the things we want a computer to do and the things we instruct the 
computer to do, and most of the time the computer is not the reason for the discrepancy. 

In the following sections, we describe three forms of software: operating systems (OSes), applications and 
data. 

1.1.4 Operating System (OS) 

Operating systems (OSes) and applications are both called programs: they give instructions to a computer to 
do some work. The reason why we distinguish these two and describe them separately is because OSes are very 
important. 

Programs control hardware, and many processes, such as accessing memory or hard disk to write or read 
information, seem to be common to all programs. Moreover, since it is cumbersome to deal with different types 
of hardware individually, it would be convenient to have a certain mechanism which can uniformly deal with 
different hardware configurations. 

An OS is a program which puts together functions such as those commonly used by different programs and 
those to control other programs. We ever hardly get a firsthand look at such hardware abstraction and resource 
management, but these functions are extremely important in the operation of a computer. 

Moreover, OSes are also important in terms of business. Programs are not created for individual computer 
hardware but for specific OSes. For example, the Microsoft Office (or Office System) software is sold for two 
OSes, namely “Windows” and “Mac OS.” In other words, you cannot use the software without one of the OSes. 

For this reason, the market share of OS is very important. It is important because software companies 
undoubtedly place more emphasis on OSes with higher market share. 

OS operations that we can actually see include the OS receiving input from the mouse and moves the pointer 
(arrow) accordingly and starting a program by a user’s click or a double click. OSes also manage files, which are 
basic units of information, and provides applications such as Web browsers and clocks. In addition, OSes 
manages a user database so that multiple users can share a PC. Strictly speaking these functions are more like 
those of applications than those of OSes, but in many cases OSes in a broad sense include such functionality. 

OSes are installed on almost all computers. This book is mainly written for Microsoft Windows XP 
(hereinafter called simply “Windows”) but Windows is not the only OS. There are also OSes which are available 
free of charge, so interested readers should refer to the bibliography ([1] Linux 演習). 

1.1.5 Application 

An application is also called application software. It is a program which provides a service actually used by a 
user. 

There are various applications for different purposes. Applications include word processors and text editors 
for creating documents, statistical processing programs and spreadsheets for numerical computation, as well as 
Web browsers and games. 
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Different applications require different operations and deal with different types of data, but the “feel” of their 
operation usually has common features which come from the OS. Therefore, once you learn the general 
operations of a particular OS, you can apply them to most applications. For example, the “click” operation of 
pressing the left mouse button once and the “double click” operation of pressing the left mouse button quickly 
twice are common to many applications. 

This kind of visual mode of operation is called a Graphical User Interface (GUI) is adopted by most 
applications. GUIs are described as having a characteristic “look and feel,” and you can perform almost any 
operation intuitively. Since it is usually easy to undo an operation later, it is important that you have an attitude 
of giving things a go without worrying about the consequences. 

At the same time, these days various services are provided through Web browsers. These services include 
Refworks, bibliographic management software that will be discussed later in this book, and Waseda-net mail, 
which is accessed from a Web browser. These services are also called Web applications. A web application is 
not run on the computer in front of you but on a remote computer called a server which provides the service. 
You need to keep in mind that web applications cannot be used unless your PC is connected to a network, and 
also you need to be aware of where the program is running and where the data is stored. Nonetheless a web 
application is a type of application software. 

1.1.6 Data 

Data is a broad concept that includes OSes and applications. But here we only deal with data in a narrow 
sense; in other words, user data. As mentioned earlier, data in a narrow sense is created by humans using some 
application (for example, word processors and spreadsheet software). 

All data is stored in a computer as numeric values. On disks such as hard disks, CDs, and DVDs, information 
is usually grouped in units called “files.” 

Files are distinguished by their file names. You can use any string of characters, including Japanese characters, 
for a file name, but it is sensible to use only “single-byte6” alphanumeric characters to avoid possible problems 
in different situations. A file name includes an extension, which usually consists of three single-byte characters. 
File extensions indicate the types of data contained in the respective file. 

Each file has a name that looks like “file.txt.” Note that a file name is made up of a name of the file (“file”) 
and an extension (“txt”) joined by a period (“.”) in between. You can set file extensions not to be displayed by 
changing Windows settings, but you should always show extensions for security purposes. Section 1.5.3  
“Settings of Windows” (p. 29) explains how to change the settings. 

The following summarizes major file types and corresponding extensions (in parentheses). Although all 
extensions are written in lower-case letters here, Windows does not distinguish upper-case letters and lower-case 
letters in file names. Some OSes distinguish between upper-case letters and lower-case letters in file names, but 
generally file names are written in lower-case letters. 

 
• Text file (txt): As the name suggests, only alphanumeric characters are recorded in this type of file. Such 

files are also called plain text. Although a text file can contain various characters in addition to 
alphanumeric characters, you have to pay attention to character codes when you use non-alphanumeric 
characters. Text files are the most basic computer file format. Some files are not text files in terms of file 
format but considered text in terms of data format (for example, XHTML and CSV). A text file can be 
created and edited by using a program called a text editor. You can use a default system editor, such as 
Notepad for Windows and TextEdit for Mac OS, but there are more sophisticated text editors which you 
can use for free. These text editors will be discussed later. 

	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 
6 This expression is not quite correct. Until we describe things more fully, we will call “A” single-byte and “あ” double-byte. 
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• XHTML file (html): An XHTML file is written in a computer language called HyperText Markup 
Language, which is used in the World Wide Web (Web). A characteristic feature of HyperText Markup 
Language is its use of a mechanism called tags to mark up information in a text file. By using tags, for 
example, you can designate a part of a document as a paragraph or a title. Since such information is 
“information about information,” it is called meta-information. Meta-information is written in text format, 
so it is a plain text data format. 

• Comma separated value text file (csv): A CSV file is a text file in which data items are separated through 
the use of commas as delimiters. Usually, each line of a CSV file contains one unit of data as in the 
following example. 

Waseda University, 1882, Shigenobu Okuma 
Keio University, 1858, Yukichi Fukuzawa 

CSV is a standard file format which can be read and written with database or spreadsheet software. Since 
CSV is a text format, a CSV file can be also viewed and edited with a text editor. 

• Microsoft Word format (doc): This file format is used by Microsoft Word, a word processor (a piece of 
software for creating documents) from Microsoft Corporation. 

• Microsoft Excel format (xls): This file format is used by Microsoft Excel, spreadsheet software from 
Microsoft Corporation. 

• Portable document format (pdf): This file format was developed by Adobe Systems Incorporated. Using 
Adobe Reader, also distributed by Adobe Systems free of charge, you can view PDF format files; however, 
you need separate software to create a file in PDF format. The most notable feature of PDF is that you can 
display and print a document using the layout it was created in on various computers. 

• JPEG format (jpg or jpeg): JPEG is an abbreviation of Joint Photographic Experts Group. The name of the 
organization which developed this image format became the name of the image format. JPEG features a 
high compression ratio and is often used for full-color images in digital cameras and other devices. 

• GIF format (gif): This is a graphics format developed by CompuServe Incorporated, which was a major 
PC communication company in the United States. GIFs can display 256 colors and also support 
animations through the storage of multiple images in the file. 

• PNG format (png): PNG is an abbreviation of Portable Network Graphics. PNG was developed 
subsequent to GIF, so it is superior in every respect. PNG also supports full-color images. However, since 
PNG uses lossless compression, you should use JPEG when a little degradation is acceptable, and use 
PNG when degradation is not acceptable or the image in question is a diagram or a chart. 

• MPEG-1 Audio Layer-3 format (mp3): MPEG-1 Audio Layer 3 or MP3 is the file format for digital audio 
compression. MP3 can reduce the size of sound data to about 1/10 of its original, while maintaining decent 
sound quality. 
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• ZIP format (zip): ZIP is a file compression format. Compressed data is decompressed to perfectly regain 
its original form (lossless compression). Since a ZIP file has a function that enables a single compressed 
file to contain multiple files, this format is used to send files over email or distribute them over the Web. A 
compressed data file is also called an archive, and software used for compression is called an archiver. ZIP 
is a de facto standard out of the many data compression formats. 

• JavaScript language (js): This language was developed by Netscape Communications Corporation and 
runs on Web browsers. JavaScript is supported by almost all Web browsers. However, the level of support 
and the language specification used vary from Web browser to Web browser. Although JavaScript can be 
disabled by changing the security settings of your Web browser, since Web applications which use 
JavaScript are becoming popular these days, you may want to enable it when necessary. JavaScript uses a 
text data format. 

• Windows computer programs (exe or com): Never run a program unless you are certain what it does. You 
should be particularly careful about any program sent to you attached to an email. 

• Visual Basic Script (vbs): Visual Basic Script is a scripting language developed by Microsoft Corporation 
based on the BASIC programming language. You should never download or open a Visual Basic Script 
file unless you are certain what it does. Unknown Visual Basic Script files are often malicious programs, 
such as computer viruses. Visual Basic Script uses a text data format. 

As you can see, various kinds of data can be handled simultaneously on a computer. It is one of advantages of 
computers that they can process different kinds of data in the same way as long as the data can be digitized. 

In many cases a single file can contain only one type of data, but you can include multiple types of data in a 
Word or Excel file at the same time. For example, you can insert diagrams, graphs and photographs in a word 
processing document. 

The last two file formats in the above list require special caution. Usually programs are created for a useful 
purpose. However, there also exist programs, such as computer viruses and worms, which are designed to 
damage computers or disclose information. Executing a program means permitting the program to perform 
basically all the operations which a user can perform on the computer with his or her access rights. If the user 
can delete any of the files on his or her computer, an executed program can also delete any of those files. 

Especially, you should exercise extreme caution when running any software downloaded from the Internet. 
That means you should not double-click anything and everything carelessly. 

1.2 Windows Basics 
This section explains Windows operations. 
Here we give explanations using Windows, and Notepad as an example application. 

1.2.1 Windows Screen Layout and Operations 

There are many versions of Windows, such as Windows 2000, Windows XP, and Windows Vista. Screen 
layout and operations may look and be slightly different due to differences in settings. 
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However, the general layout of each version of Windows is about the same. The look of a GUI-based OS often 
changes from version to version, which is a nightmarish problem for those who write a textbook like this one. 
But actually changes in appearance are not such a big problem. Do not worry about small changes, focus on 
accomplishing your current objective on the computer, and try and learn even if the screen in front of you looks a 
little different from the images in this textbook. 

For the Windows XP settings used in this section, refer to 1.5.3 “Settings of Windows” (p. 29). 
Figure 1.2 - Figure 1.4 show the Windows XP screen elements. 
 

 

Figure 1.2: Desktop Icons 

	
 

 

Figure 1.3: Start Button 

	
 

 

Figure 1.4: Input Method Editor (IME) toolbar 

	
 

Because of space limitations, elements which are usually scattered on the screen have been laid out side by 
side. 

In Windows, the screen where the My Computer7, Recycle Bin and other icons are located is called the 
desktop. This is a metaphor for a physical desktop: for example, you can set out files here. The desktop usually 
has icons such as My Computer, My Documents, My Network Places, and Recycle Bin, depending on the 
settings. 

You use My Computer for accessing auxiliary storage devices connected to your computer, such as hard disks, 
USB flash memory, FD drives and CD-ROM drives. Strictly speaking, you are accessing the Windows file 
system. We will discuss this in more detail in 1.3 “Understanding and Using the File System” (p. 21). 

Place the arrow (pointer) on the My Computer icon using the mouse, and press the left mouse button twice 
quickly (doing this is called “double clicking"). This operation means “to open.” In general, pressing the left 
mouse button once (to click) means “to select” and twice (to double click) means “to open.” 

The screen usually changes as shown in Figure 1.5 My Computer Opens” (p. 10), depending on your 
computer’s settings. 

The rectangular frame that has just been displayed on your screen is called a “window.” 
In Windows, almost all tasks are done in such windows. You must be aware that windows and the desktop are 

arranged in layers. Parts of the desktop are hidden underneath the windows displayed. You cannot work on such 
hidden parts of the desktop. 

 

	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 
7 Applicable only in Japanese manual. 
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Figure 1.5: My Computer Opens 

You can open many windows at the same time, but these windows are arranged in layers, too. When you open 
many windows, they are arranged in layers, and basically you can only work on the window that is on the top. 

You should be able to tell which window is the top window just by looking, but the most certain way to find 
the top window is to look at the title bar of the window. The title bar of the top window is graduated from navy 
blue to azure, while the title bars of the other windows are gray (see Figure 1.6 “Active and Inactive Windows”). 

 

 

Figure 1.6: Active and Inactive Windows 

To move a window to the front, simply click somewhere on it. The clicked window then becomes the top 
window, and the previous top window becomes the second-topmost window. However, you cannot bring a 
hidden window to the front in this way. See the bottom of the screen. Figure 1.7 “Taskbar” shows the taskbar, in 
which open windows are displayed as the taskbar buttons. (Since whether the taskbar is always displayed 
depends on its settings, you may have to move the pointer (with the mouse) all the way down to the bottom of 
the screen to make it appear.) You can bring a window to front also by clicking the respective taskbar button. 

 

 

Figure 1.7: Taskbar 

You can perform several operations on a displayed window. 
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These operations include resizing, maximizing, minimizing, closing or moving the window. 
First, look at the upper-right corner of a window. You see three buttons lined up here (see Figure 1.8 “Buttons 

at the Upper Right”). From the left, these buttons minimize, maximize and close the window, respectively. 
“Minimizing” means hiding the window. This button does not close the window but just hides it so that the 
button for the window remains on the taskbar. “Maximizing” means displaying the window full screen or at its 
maximum displayable size. Clicking the “close” button closes the window. 
	
 

 

Figure 1.8: Buttons at the Upper Right 

The Close button has different effects on different software. While we are playing around with the Windows 
desktop, we are actually using a particular piece of software called Explorer. When using Explorer, clicking the 
Close button simply closes its window. Different software responds differently. This is explained in 1.2.2 
“Starting and Exiting Applications.” 

In many cases, in addition to minimizing and maximizing a window, you can change its size as you like. If 
you move the pointer to the top, bottom, right, or left edge of the window, you will see the pointer changes its 
appearance from an arrow to a double-headed arrow (up/down or right/left). Or if you move the pointer to the 
upper-right, upper-left, lower-right, or lower-left corner of the window, you see the pointer changes from an 
arrow to a diagonal double-headed arrow. Move the mouse while the pointer has this shape while holding down 
the left mouse button (this action is called “dragging”). When you reach the window size you want, release the 
left mouse button. 

You can move a window anywhere on the desktop by dragging its title bar. 
You can see a Recycle Bin icon on the desktop. The Recycle Bin is for the disposal of files (“deletion”). To 

delete a file, drag the file you want to delete to the Recycle Bin. Next, place the pointer on the Recycle Bin and 
right-click (Figure 1.9 “Right-clicking”). 

 

 

Figure 1.9: Right-clicking 

In most Windows applications, right-clicking means “to show command options for the item right-clicked 
on.” When you right-click the Recycle Bin, commands such as “Open,” “Explorer,” “Empty Recycle Bin,” 
“Create Shortcut,” and “Properties” are displayed. If the Recycle Bin is empty at this time, you will not be able 
to select the “Empty Recycle Bin” item. 
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Next, right-click anywhere on the desktop. You see a menu which is different from the one opened when you 
right-clicked the Recycle Bin. 

1.2.2 Starting and Exiting Applications 

No user uses only the Windows OS. You must have other objectives, like wanting to use a word processor or 
browse the Web. We have applications for these purposes. 

Another word for an application is a program. Applications are used for giving a series of processing 
instructions to a computer. A program is also a copyrighted work, like literary works and this textbook, and is 
created by humans. Therefore, you need to obtain a program legitimately from somewhere and install it on your 
computer to use it. 

In many cases, applications are products so that you cannot obtain them for free. However, you should 
definitely take advantage of those applications that can be used free of charge. 

When you purchase a computer, some programs may be already installed on it (these programs are said to be 
“preinstalled”). For example, many computers are sold with Microsoft Windows preinstalled. Microsoft Office is 
also preinstalled in many cases. Whether you use a computer room at university or your computer at home, first 
of all you need to prepare software which suits your purpose. 

Windows comes with many useful applications, albeit they are not functionally rich. These applications are 
generally called utilities and, include, for example, Calculator and Notepad. Here we use Notepad as an example 
and learn about basic application operations, including starting and exiting an application. 

To use an application, first you have to start it. When an application is started, it is read from the hard disk to 
RAM and then run. 

In the case of Windows, almost all tasks can be started by clicking the Start button at the lower-left corner of 
the screen. The menu this displays is called the Start menu. To display a list of applications, you click Start and 
then click Programs. Here we use Notepad as an example. Notepad is used for creating and editing text files 
mentioned above (see 1.1.6 “Data” (p. 6)). Its main purpose is to create a short text document or a note, as its 
name suggests. Although it is more convenient to use an editor (a piece of software) which you can obtain for 
free for editing a text file, we use Notepad, a Windows system default application. In this textbook, the above 
procedure of clicking the Start button and then the Programs command is written as Start → Programs from on 
this point forward. For example, you can start Notepad by clicking Start → Programs → Accessories → 
Notepad (see Figure 1.10 “Start Menu” (p. 13)). 

When you start an application, a new window for working with the application is almost always displayed. 
For Notepad, a window as shown in Figure 1.11 “Notepad” (p. 13) is displayed. You can use the operations you 
have learned in the previous section 1.2.1 “Windows Screen Layout and Operations” (p. 8). To type characters 
here, press the corresponding keys on the keyboard. 

1.2.3 Entering and Converting Characters 

There are various ways to enter characters. Nowadays you can enter data with a microphone by speaking, but 
doing all data entry in this manner is not very practical. Most likely, you will probably type in characters from 
the keyboard, so typing is one of the most important points of mastering computer use. 
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Figure 1.10: Start Menu 

	
 

 

Figure 1.11: Notepad 

What you need to do to master typing is to practice typing in characters until you get used to the keyboard. 
You do not need to know any theory in order to learn how to use the keyboard. To remember the arrangement of 
the keys, it is more efficient to learn it with your fingers than memorizing it. Typing without looking at the 
keyboard but instead looking at the characters being displayed on the screen is called “touch typing.” Practice 
until you master touch typing. 

In order to get used to the keyboard, it may be a good idea to use an application for typing practice. There is a 
correct method of typing keystrokes. Some people say you can type in your own style, but from the point of view 
of efficiency and your health8, the correct way is the best way. 

In Waseda University, an application called “キーボード練習 (Keyboard Practice)” is available in computer 
rooms. You need a FD, a magnetic optical disk (MO), or USB memory to store your practice data, so be sure to 
bring one with you when you use the application for typing practice. There are many different typing practice 
applications on the market today and Web sites which offer typing training online. Please make good use of 
them. 

If you press a key while Notepad is running, the character written on the key should be displayed on the screen. 
See Figure 1.12 “Keyboard (Partial View)” (p. 14). Typing a character while holding down the key with “↑ 
Shift” written on it (the Shift key) should cause the respective upper-case letter to be displayed. There are also 
the number keys in the upper area of the keyboard. You can see a number labeled on the lower half and a symbol 
labeled on the upper half of each key. When you press one of these keys while holding down the Shift key, the 
character on the upper half of the key will be entered. 

In order to enter Japanese characters, press the key which reads “半角/全角” on the upper left of the keyboard. 
You can switch Japanese Language Input on and off using this key. 

 

	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 
8 Office work using a display or similar devices is called visual display terminal (VDT) work. Prolonged VDT work in an uncomfortable working 

environment or posture may cause visual, physical, or mental distress (VDT Syndrome). A student using a computer with their legs stretched out is a 
common sight, but this posture burdens the lower back, elbows and wrists. If you continue to use computers in future, do not take ergonomics lightly and 
learn how to work correctly with a computer sitting in the correct posture. 



Chapter 1  PC Basics 

14 

 

Figure 1.12: Keyboard (Partial View) 

When you switch on Japanese Language Input, in most cases you can enter Japanese characters using the 
Hepburn Romanization system. To enter “わせだだいがく,” you type “wasedadaigaku.”9  

A description of Hepburn Romanization is outside of the scope of this book. 
You can enter small hiragana characters (for example, a small “あ” character) by typing “x” before regular 

characters (for example, ““xa” is “ぁ”). With some Windows settings, you type “l (lower-case L)” instead of 
“x.” In other words, typing “la” converts to “ぁ.” 

Start Notepad and try to type some characters in Japanese. Also try to enter Japanese characters while using 
the “半角/全角” key to switch Japanese Language Input on and off. Although it depends on the settings of the 
PC, in many cases the display of the language bar on the lower-right corner of the window also changes (see 
Figure 1.13 “Japanese Language Input is OFF” and Figure 1.14 “Japanese Language Input is ON”). You can see 
for yourself that “A” or “あ” appears alternately every time you press the “半角/全角” key and type. 

To delete a character, press the key marked Backspace or BS or the key marked Delete or DEL. Since the 
Delete key and the Backspace key delete characters in different ways, see for yourself how they work. 

 

  
Figure 1.13: Japanese Language Input is OFF Figure 1.14: Japanese Language Input is ON 

Try to enter “きょうはいしゃにいった” and then convert the string into hiragana and kanji by pressing the 
Spacebar. This phrase can be converted in different ways. Say you want to convert it into “今日は医者に行っ
た.” Note that the conversion depends on how the phrase is divided into words. 

After you finish typing your characters, you convert them into hiragana and kanji. When Japanese Language 
Input is on, you can convert the characters you typed by pressing the Spacebar (the key with nothing printed on it 
in the bottom row of the keyboard.) Because of progress in the study of computer language processing in recent 
years, the characters you typed are likely to be converted into your kanji you wanted. However, keep in mind 
that incorrect conversion or the dividing up of a phrase into the wrong syllables still occurs routinely. 

Is the Japanese displayed what you had in mind? If it is not, you will need to correct it. In Japanese Language 
Input mode, conversion from Romaji to hiragana is carried out automatically. But since the dividing up of a 
phrase into words is left entirely up to your computer, an error may occur in the way the phrase is divided and 
when the words in the phrase are converted from hiragana into kanji. If there are no errors, press the Enter key to 
confirm the conversion. 

	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 
9 In addition, depending on the setting of your PC, you can use “kana input mode.” In this mode, you can directly type using the hiragana labeled on the keys 

of the keyboard. If you are used to this mode, typing Japanese in this mode will be more efficient than typing with Romaji. However, there are 50 hiragana 
characters compared to 26 alphabetic characters. You will need to memorize the alphabet key arrangement anyway, so the number of keys you need to learn 
for kana input exceeds 76. Therefore, we recommend using Romaji input. 
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What you want to do here is to change the points where the phrase is divided into words and convert those 
words from hiragana into kanji. 

 

   
Figure 1.15: Before Words Are 

Converted 
Figure 1.16: Changing the Divisions 

between Words 
Figure 1.17: Reconversion 

Figure 1.15 “Before Words Are Converted” shows the phrase before the divisions between words are changed. 
Although this phrase makes sense in Japanese, since our goal is to create “今日は医者に行った,” this is not 
what we want. The way the phrase is divided into words is wrong. The characters underlined in Figure 1.15 - 
Figure 1.17 represent where the conversion of hiragana into kanji has not been determined, and the gap in the 
underlining represents a division between words. The thicker underlining represents the word you are working 
on right now. By pressing the Left and Right arrow keys, you can move the division in the phrase. Visually, the 
end of the thicker underling moves to left or right. By pressing an arrow key while holding down the Shift key, 
you can change the length of a word. Since you can always return to the original phrase until you confirm your 
conversion selection by pressing the Enter key, you should try changing the word. 

Here you change the first syllable to “きょうは.” Press the left arrow key to move the thicker underline to the 
leftmost position, and adjust the length of the syllable by pressing the arrow keys while holding down the Shift 
key. The screen should change as shown in Figure 1.16 “Changing the Divisions between Words.” Next, press 
the Spacebar for reconverting at the changed word break. The screen changes as shown in Figure 1.17 
“Reconversion.” Change “言った” to “行った” to create the target phrase, and press the Enter key to confirm 
the hiragana/kanji conversion. 

It is rather confusing to describe in words how to enter characters, but the operation itself is simple. Once you 
get used to it, there is nothing to it. Entering characters is all about practice. In order to get used to it, you should 
consolidate your university activities on your computer as much as possible. You may not be good at it and it 
may take time at first, but you will get better over time. 

1.2.4 Handling of Characters on a Computer: Character Codes 

In the preceding section, you entered a sentence, was albeit a short one. This section explains how characters 
are handled inside a computer. 

Characters are expressed as numeric values inside a computer. Since computer can handle only electrical 
signals, 0 and 1, it expresses numbers by combining several 0s and 1s (i.e. binary numbers). And it expresses 
characters by assigning each character to a certain value. 

The question is how to set up the correspondence between characters and numeric values. That is, we need a 
conversion table of numeric values and characters. Moreover, when you exchange characters in the form of text 
with other people, things get even more complicated. If people use different conversion tables of numeric values 
and characters, the interchange of information will become impossible. 

To solve this problem, standards have been developed. For alphanumeric characters, the American Standard 
Code for Information Interchange or ASCII is used. ASCII was defined in 1963 by the American National 
Standards Institute (ANSI). As per its name, ASCII was originally developed for the purpose of interchanging 
information. But since it is a waste of effort and resources to prepare another code, ASCII is usually used for 
everything, from internal-computer processing to information interchange. 
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If the only characters we use consist of just alphanumeric characters and symbols, then there not so many of 
them. There are 128 ASCII characters, including upper-case and lower-case letters of alphabetic characters, 
numbers, symbols and control characters (tab, linefeed, etc.). Each character is assigned a number between 0 and 
127, and this assignment takes only 7 digits or 7 bits in binary form. Therefore, the amount of information 
required to express ASCII characters is single-byte per character. 

On the other hand, if we use the Kangxi Dictionary, there are about 50,000 characters in the Japanese 
language. Even though all of them are not used, the so-called List of Kanji Characters in Common Use alone has 
1,945 characters, which cannot be represented using just single-byte. Therefore, Japanese characters use 
double-bytes per character. There are conversion tables for hiragana, katakana, kanji, etc. and numeric values for 
Japanese, too10. Such conversion tables have been defined by Japanese Industrial Standards (JIS) and other 
organizations. In PCs with Windows or Mac OS, the shift JIS encoding is often used. 

Other character encodings include JIS, EUC, and UTF-8. Usually, software automatically detects which 
character encoding is used in a document. However, software sometimes fails to auto-detect the character coding, 
and as a result the characters look like gibberish (this phenomenon is called mojibake, literally “garbled 
characters”). As just described, the present Japanese character encodings have various problems. So a new 
standard has been established in order to address these problems. In the near future, the Unicode character 
encoding (in many cases consisting of the UTF-8 encoding system and the JIS X 0213 Plane 111 and Plane 212 
character sets) will very likely be used predominantly. 

Incidentally, the expressions “半角 (single-byte)” and “全角 (double-byte)” are relics from the time when we 
had only dedicated word processing machines. Back then, some single-byte or double-byte characters were 
displayed using half the width of hiragana or kanji, so these expressions were born. In fact, although this 
depends on the font used, the width of a single-byte character is not necessarily half of that of a double-byte 
character. (Just for the sake of experiment, type the double-byte character “i” and the single-byte character “W” 
10 times each and compare the lengths of the strings of characters.) Therefore, strictly speaking these 
distinctions are inaccurate. However, since the terms are already commonly used in Japan as you can see from 
the “半角/全角” key of the keyboard, in this book we will not fuss over details and will use the terms 
“single-byte” and “double-byte” throughout13. 

A particularly problematic point with regard to single-byte and double-byte characters is the treatment of 
katakana. Avoid using single-byte katakana as much as possible. Although you can use single-byte katakana at 
the moment and probably continue to be able to do so in the future, single-byte katakana is included only for the 
purpose of allowing old data to be used without causing problems. You are supposed to avoid using single-byte 
katakana as much as possible. As a rule of thumb, you should stick to the following rules to obtain problem-free 
(and good looking) results. 

• Use double-byte hiragana, katakana, and kanji. 
• Use single-byte alphabetic characters, Arabic numbers, and symbols if possible. 
• Use double-byte parentheses when double-byte characters are in them. 
• Use double-byte punctuation marks (“、” and “。”), centered dots (“・”), and long vowels (“ー”). 

• Do not use platform-dependent characters (such as full-size encircled numbers, Roman numerals and cell 
phone pictograms). 

However, projecting characters on a screen for presentations or displaying them Web publishing requires that 
they be handled differently than when they are printed on paper. Using different fonts make a difference, too. 
Therefore, the above rules do not always apply. Depending on the circumstances, you should select the 
	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 
10 Strictly speaking, we need to consider both “coded character sets” that determines which characters to include in a conversion table and “character encoding 

schemes” that determine the correspondence between characters and the numbers that represent them, but we will skip that discussion for the sake of 
simplicity. 

11 http://www.itscj.ipsj.or.jp/ISO-IR/233.pdf  
12 http://www.itscj.ipsj.or.jp/ISO-IR/229.pdf  
13 What is more, the expressions “single-byte characters” and “double-byte characters” are not quite correct, either. But we will not discuss this any further. 

Those who are interested should refer to the bibliography. 



1.2  Windows Basics 

17 

characters that you use while checking what will be the final result, but you should also be consistent as far as 
possible. We will discuss this subject further in Chapter 6 “Basics of Report and Paper Writing” (p. 69). 

The last point in the above-mentioned list is particularly important. “Platform-dependent characters” are 
characters which are displayed correctly only on a specific computer or OS. There are surprisingly many of them, 
and they are also widely used. Some platform-dependent characters which are frequently used on Windows are 
given in Figure 1.18 “Some Platform-dependent Characters.” Text which includes these characters may cause a 
problem later when used as data. Sometimes it causes a problem when it is received. For example, an encircled 
number may be displayed as “〓,” “□,” “・,” or even as a completely different character. 

 

 

Figure 1.18: Some Platform-dependent Characters 

Character codes have various problems, too. It is very difficult to reproduce the vast and profound activity that 
is language faithfully on a computer to begin with. The computer reproduction of language always involves a 
certain kind of inevitable absurdity. Although this state is gradually improving, you should remember when you 
read or write a text using a computer, you need to pay attention to what type of data you are creating, who will 
receive the data, and if the data has been received in the form you have created it. 

It is already difficult for you to have others understand your words in the way you have intended. At the very 
least you want to deliver them in the correct form. 

1.2.5 Saving Files 

You have now entered some characters. In other words, you have created new data using the application 
Notepad. The data is stored in the main memory (RAM), and the data will be lost when you exit Notepad or turn 
off the power of the computer. If you want to keep this data for later use, you need to save the data as a “file.” 

We mentioned files before (see p. 6). Since the data has been created in the form of a “text file” here, note that 
its extension will be “txt.” 

On the File menu of Notepad, click Save As ... (see Figure 1.19 “File Menu” (p. 18)). 
You can save a file by using Save or Save As…14. Save overwrites the file you are currently editing. Save 

As… leaves the file you are currently editing in its original form and create a new file. 
Since you are not editing an existing file but creating a new file right now, either way you will save the file in 

the same way when you select Save As… 

	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 
14 Note that a menu command with three periods “...” indicates that the operation requires additional instructions. In such cases a separate window called a 

“dialog box” opens. 
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Figure 1.19: File Menu 

A window as shown in Figure 1.20 “Save As… Dialog Box” is displayed. 
 

 

Figure 1.20: Save As… Dialog Box 

There are two points for you to pay attention to here; these are: (1) what file name you give your file, and (2) 
where you save it. 

Type a file name in the text field labeled “File name:” in the dialog box. It already contains “*.txt,” but it is 
OK to delete this text. Type “memopad-lesson.txt” as the file name into the text field. 

There are some characters you cannot use in a file name (for example, you have to erase the asterisk “*” from 
“*.txt” in order to save your file.) Also there are other characters you should avoid. In particular, you cannot or 
should not use the following characters. 

 
/ : * ? “ < > | # { } \ % & ˜  Yen symbol (¥), tab, and multiple periods 
 
Next, have a look where you will save your file. On the upper-left of the dialog box, you can see the label 

“Save in.” On the right-hand side, you can see a “▼” shaped button. Click this button to show the list of places 
where you can save your file (see Figure 1.21 “Pull-down List” (p. 19)). 

The box in the figure is for the “My Documents” folder. 
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Figure 1.21: Pull-down List 

 
This folder is not just for Notepad; many applications use this My Documents folder as a standard15 place to 

save files in. The (default) destination to save files in the computers in the general computer rooms of Waseda 
University16 is mostly the H drive (H:¥). Keep in mind that in computer rooms the contents of the H drive will 
be erased every time a computer is restarted. 

You may have no idea where the My Documents folder or the H drive is to be found in a computer right now, 
but this will be discussed in 1.3 “Understanding and Using the File System” in detail. You can save your file 
either in My Documents or the H drive here. Just click the Save button to save the file. After you save the file, 
close the window by clicking File → Exit or by clicking “×” at the upper-right corner of the window.  

Not just in Notepad but in many applications, when you try to exit a program after doing editing such as 
entering, deleting or replacing characters without clicking Save or Save As…, you will be asked if it is OK to 
lose your changes when you exit the program (see Figure 1.22 “Warning to Ask for Saving Changes”). 

 

 

Figure 1.22: Warning to Ask for Saving Changes 

 

1.2.6 Notes on File Names and Folder Names 

You may well wish to use Japanese characters in file name or folder names, but if you use only single-byte 
alphabets, numbers, hyphens, parentheses, and underscores, you may be able to avoid trouble when the file or 
folder is used later17. Also long file names may cause troubles when the files are used later, never mind that they 
are hard to read to begin with. Keep your file names as simple as possible. 

	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 
15 When we are talking about computers, we call such a standard a “default.” 
16 MNC calls these settings the “standard environment.” 
17 In particular, some applications do not support characters, including kanji, other than single-byte alphanumeric characters and symbols in a file name when 

the respective file is attached to an email. 
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Most importantly, you should name your file in such a way that you can understand what they contain when 
you look at their file name. Obviously file names like “test,” “memo,” “text,” and “report” do not say much 
about the content of the files. As the number of files you manage increases, having consistent naming rules 
becomes more beneficial. Conversely, if you do not know where your files are, files you have created will lose 
their usefulness. 

If you remember its keywords, you can find a file by using a search tool. Search technology has been 
developed partly because the amount of information now stored in a computer is so massive that it becomes 
difficult to find something even if we keep our data well-organized. But organization is still the best way to 
manage your files. 

There are many ways to organize files, such as organizing them in chronological order (by year and month, 
etc.) or by topic. Organizing files is one of the key points of mastering computer use. Even if some people are 
used to using a computer, it does not necessarily mean these people (including the authors of this textbook) are 
good at managing files. Ultimately we have to seek and find our own methods of file management which suit us 
individually. You should try different methods while you have only a small number of files to manage. 

1.2.7 Editing a File 

Let us edit the saved file. There are two approaches to editing the saved file. One way is to double-click the 
file and another way is to start Notepad and open the saved file. 

As mentioned earlier, each file has an extension according to its file type. When you double-click a file, the 
appropriate application is started depending on the extension, and the file is opened by the application. It seems 
complicated when described, but in short, when you double-click a file with the extension “txt,” Notepad usually 
starts18. 

However, it is very dangerous to get too used to double-clicking everything. Especially, be cautious with files 
you did not create yourself. Moreover, depending on the Windows settings, extensions may be hidden. But since 
such a configuration is very dangerous, be sure to show extensions at all times. 

Another method is to start an application first and then open the saved file from the application. This is a safer 
method. 

Start Notepad, and click File → Open... A dialog box similar to the one you used when you saved a file is 
displayed (see Figure 1.23 “Open… Dialog Box” (p. 21)). 

Since the “Files of type:” text field says “Text Documents (*.txt),” only folders and text documents with the 
extension txt are displayed here. Some files, for example HTML, are text documents although their extension is 
not txt. If you wish to open such a file, click “Files of type:” and select “All Files.” 

When you find a file you want to open, click the file and click the Open… button. 
Now you know how to display the files stored in an auxiliary storage unit and edit their contents. However, 

you should note that the data you are going to edit is that which is read from the auxiliary storage unit to the 
memory. Until you save the data or save it under a different name, its contents will not be stored from the 
memory to the auxiliary storage unit. 

	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 
18 You can change this association between extensions and applications. 
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Figure 1.23: Open… Dialog Box 

 

1.3 Understanding and Using the File System 
The previous section 1.2 “Windows Basics” (p. 8) explained Windows itself. But what is critical in mastering 

computer use in general is file management. A file is the most basic unit of information managed in a computer. 
The file system is a system which manages files, and understanding the file system is essential to the efficient 
use of a computer. 

The popularity of digital cameras and broadband Internet services as well as the growing capacity of general 
hard disks all contribute to the increase in the number of files. If files are not managed efficiently and effectively, 
important information may be buried or lost by mistake or due to an accident. 

When you start using a PC, you may not feel that file management is very important. But remember that the 
number of stored files will increase over time, not decrease. 

It takes a little imagination to understand a file system. Aim to be able to visualize the file system. 

1.3.1 File System 

A file system is a system which manages files. “File system” is a general term, and each OS uses its own 
unique file system. So, Windows has its Windows File System, with unique features of its own. 

Generally, a file system accesses compartmentalized data arrays, “sectors,” on an auxiliary storage unit such 
as a hard disk. A sector is a block created when a disk is initialized (formatted). You can imagine it is like 
drawing lines using chalk in a schoolyard. A file system builds files and directories using such blocks and 
manages things like which files are recorded in which sectors. 

We use such a file system whenever we use a computer, but we rarely notice it exists. When we use a 
computer, what we are actually doing is create or editing files, or downloading them over a network and store 
them on a PC. In other words, files have a central role. 
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The average number of files managed on a computer is increasing steadily due to the growing capacity of hard 
disks and sophistication of software. Therefore, the key to your mastery of computer use is whether or not you 
can manage files well. 

1.3.2 Files and Directories 

Each file has a file name, by which files are identified. A form of correspondence table between these file 
names and the location of the files (where the files are stored on the disk) is managed in the file system. 

A “directory” is a container for files put into it. Most versions of Windows call these directories “folders.” 
You may use a plastic folder to put your documents in; these Windows folders are used in a similar way, hence 
their name. 

You can put a folder in another folder. When there are two folders in a hierarchical relationship such as this, 
the “outermost” (i.e. the folder which contains the other folder) is sometimes called a parent folder (or parent 
directory), and the “inner” folder (which is contained in the other folder) is called a child folder (or child 
directory). 

As seen above, a file system is composed of hierarchical relationships. When the entire relationship structure 
is depicted, it looks like the spreading roots of a tree. If we turn the picture upside-down, it looks like the 
spreading branches of a tree. This structure is therefore called a “tree structure.” Figure 1.24 “Tree Structure” 
shows the tree structure of a typical Windows hard disk. 

 

 

Figure 1.24: Tree Structure 

Drive letters, characters for identifying disks, are at the apex of the tree structure. However, since this is a tree, 
the apex is called the “root.” As we can see, a tree structure features only one apex at its top and multiple 
children underneath it. 

The drive letter “C:” is typically assigned to the built-in hard disk drive. The drive letter “A:” is usually 
assigned to a built-in FD drive, if one is installed. Other drive letters are assigned arbitrarily depending on the 
configuration of the PC. If you double-click the My Computer icon on the desktop to open it, you can see the list 
of all the drives on your PC. Drive letters are indicated in parentheses in this list. 
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When you want to uniquely specify a file with characters, you use the yen symbol “¥” as a separator to divide 
up the file and folder name(s). For example, the file named WINWORD.EXE in the folder OFFICE11 in the 
Microsoft Office folder under the Program Files folder on the C: drive can be expressed as follows: 
C: ¥Program Files¥MicrosoftOffice¥OFFICE11\WINWORD.EXE 

Such a description that includes all folders you have to go through to reach the target file is called a “path.” It 
is like a road map to a file or a folder. Here we have a path from the root C: drive to a file. To be exact, such a 
path is specifically called a “full path.” 

But when we actually work on a file, we rarely use a path in this way. Usually we double-click My Computer 
on the desktop, and click the folder which contains the target file and so forth. This means we are going down 
the tree structure one level at a time. 

Nonetheless it helps to know which file we are working on when we are using a file system (that is, when we 
are using Windows). For a similar reason, it helps to know roughly where in the hard disk you can find which 
files. This is explained in the next section. 

1.3.3 Windows Disk Layout 

The contents of the disk on which Windows is installed look like Figure 1.25 ““My Computer” Opened.” This 
window may look different on your PC. If so, on the View menu of the window, click Detail. The window will 
then look like Figure 1.25. 

 

 

Figure 1.25: “My Computer” Opened 

In this window, disks are displayed, classified into “Hard Disk Drives” and “Devices with Removable 
Storage.” You can see drive letters C, A, and D are assigned to the hard disk drive, the FD drive, and the CD 
drive respectively. 

The C Drive contains three main folders. 
 
• Documents and Settings 
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• Program Files 

• WINDOWS 

Out of these, the WINDOWS folder19 stores the Windows OS and device drivers. The Program Files folder 
stores various programs. 

Let us open the Documents and Settings folder. You should be able to see a folder with the user name you are 
using right now in Windows as well as the All Users folder. If two or more users share the computer, you will 
see multiple folders. Open the folder which has your user name on it. Folders such as the following may be 
displayed (the exact list will vary): 

 
• Cookies 

• My Documents 

• Favorites 

• Start Menu 

• Desktop 

Among these, the My Documents folder is the folder associated with the My Documents icon displayed on the 
desktop. Similarly, the Desktop folder contains the contents of the Windows desktop. Since it may be a little 
confusing, let us open the Desktop folder. Next, right-click anywhere on the Windows desktop and click New → 
Text Document. 

You can see that a new file called New Text Document.txt has been created on the desktop, and, at the same 
time, an identical file is created in the Desktop folder. If you delete one of them (e.g. by dragging it to the 
Recycle Bin), the other file is also deleted. 

In other words, My Documents does not exist on the desktop but is stored in a folder on the C Drive in most 
cases, and the same applies to the other files on the desktop. 

The Favorites folder stores Internet Explorer Favorites. The Cookies folder is used by Web browsers, and we 
will discuss cookies in more detail in 2.4 “World Wide Web” (p. 38). 

Working with a computer means creating and editing files. Therefore, you need to be always aware which 
folder the file you are editing is actually stored in. Each user’s folder in Documents and Settings is very 
important because it is the folder which contains the user’s work on the computer. 

At the very least you should back up this folder. The next section “Backup” explains how to make backups. 

1.4 Backup 

1.4.1 Why We Need Backups 

We use various storage media, such as hard disks, CD-Rs, DVD-Rs, and USB flash drives, to store files. We 
tend to think that the information recorded on these media can be used on a relatively permanent basis. However, 
none of these can hold data forever. 

	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 
19 This book uses all upper-case letters for the WINDOWS folder, and for other folders such as Program Files, only the first letter of each word is capitalized. 

However, note that Windows does not distinguish between upper-case and lower-case letters in file names. 
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In the mechanism of a hard disk, a metal or glass disk coated with a magnetic substance spins at high speed in 
a box. Due to this mechanism, all hard disks will break down and stop eventually. A hard disk has a mean time 
between failures (MTBF) of about 300,000 to 600,000 hours, though MTBF varies depending on products. 
However, even though a hard disk is said to last 300,000 hours on average under ideal operating conditions, your 
hard disk may break down tomorrow or work for 10 years without a failure20. 

Smaller hard disks like the ones used in a notebook PC tend have shorter life spans, and ones used in a 
desktop PC tend to have a longer lifespan. A higher operating temperature for a hard disk shortens its MTBF. 
That is, the prolonged use of a hard disk in a harsh environment will increase its chance of failure. The interior of 
a computer is surprisingly hot, and with added dust the MTBF becomes even shorter, and the probability of the 
hard disk breaking down in the near future increases accordingly. 

Let us repeat here: there is no such thing as an unbreakable hard disk. You do not need to worry too much, but 
under no circumstances think that your hard disk is an exception and will last forever. 

CD-ROMs, CD-Rs and DVD-Rs have far shorter life expectancies than hard disks. They last at the longest 20 
years and typically about several years. A harsh, high-temperature and humid environment can cause these 
media to deteriorate in several weeks. 

The maximum times that USB flash drives can be rewritten range from several tens of thousands to one 
hundred thousand times. You can read recorded data from USB flash drives from several years to a maximum of 
10 years. Moreover, since USB flash drives are portable, they are tend to get damaged accidently or lost. Also 
since they are frequently plugged and unplugged from USB ports, their connectors tend to get damaged. 

Using a computer means mostly handling (create, edit, etc.) files. But it is difficult to store files safely. In 
short, you must take backups of your important data on a separate disk. 

So you must have a separate hard disk for the purpose of taking backups. This hard disk should only be used 
for storing backups. As of March 2008, external USB hard disk drives can be purchased at below 10,000 yen for 
250 GB. This is by no means inexpensive, but considering the value of your time and of the information you 
have produced, it is not too much of an investment. Also, be sure to take backups regularly. 

1.4.2 Making Backups 

The easiest way to create a backup is to simply copy files to the backup destination. But as your number of 
files increases, making backups becomes increasingly troublesome. Keeping record of which files have been 
backed up when is not realistic, but on the other hand backing up all of the files every time you do so takes too 
much time. In this section we consider the use of backup software. Backup software comes with Windows 2000 
and later as standard21. To display the Backup or Restore Wizard dialog box, click Start → Programs → 
Accessories → System Tools → Backup.  

In this dialog box, basically you can create a backup by selecting the operations you want to perform and 
clicking Next. Several key points are explained below. 

First, there are four options as for what to back up. If you want to specify the items you want to back up, click 
“Let me choose what to back up.” If you want to make a full backup, select one of the other three options. “My 
documents and settings” backs up the My Documents folder and settings of the current user of the PC.  

	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 
20 It is known that the failure probability of a hard disk conforms to the Poisson distribution. 
21 However, if you use Windows XP Home Edition, you will need to install additional software. Put the installation CD in the CD drive, click VALUEADD 

→ MSFT → NTBACKUP, and double-click the NTBACKUP.MSI file to start installation. Windows Vista uses a different backup method. Click Start 
→ All Programs → Maintenance → Backup and Restore Center. You can create a backup from this window by clicking Back up files or Back up 
computer. Windows Vista has several different editions, and the types of backup you can make vary depending on which edition you have. 
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“Everyone’s documents and settings” backs up the documents and settings of all the users registered with the PC. 
“All information on this computer” creates a complete copy of the files on the PC. You can restore the exact 
state of the PC at the time you made the backup later. 

Next, specify a place to save your backup. Since you cannot use a CD-R or DVD-R here, have a dedicated 
hard disk as mentioned above ready and specify the hard disk as the place to save your backup. 

You should be able to find the Advanced ... button on the Completing the Backup or Restore Wizard window. 
You can fine-tune the settings by clicking this button. 

“Type of Backup” specifies the type of backup. Your choices include Normal, Copy, Incremental, Differential, 
and Daily backups. See Figure 1.26 “Type of Backup.” In this diagram, the initial state of the hard disk is (1), 
and the data subsequently added is (2) and (3). 

 

 

Figure 1.26: Type of Backup 

A normal backup backs up all backup target files of each generation, such as (1), (1)+(2), and (1)+(2)+(3). An 
incremental backup backs up the entire (1) in its initial state, but backs up only the additional data (2) in the first 
generation backup and the additional data (3) in the second generation backup. 

A differential backup may be a little difficult to understand. It is similar to an incremental backup, but differs 
from an incremental backup in that a differential backup copies the files created or changed since the last normal 
backup. The advantage of a differential backup over an incremental backup is that all you need to restore the 
latest state is a normal backup and the last differential backup. If you use an incremental backup, you need to 
have the initial backup and all the incremental backups performed after that to restore the latest state. 

You should choose a backup method based on the capacity of the backup destination drive and the amount of 
time allowed for backup. In general it is recommended to perform a normal backup when the amount of backup 
target data is small. When the amount of backup target data is large, perform a normal backup once a week and a 
differential backup the rest of the days of the week. 

When backup data already exists, the “Backup Options” specifies whether to delete the existing backup data 
and make a new backup or keep the old backup data and append the new backup to it. Naturally replacing 
existing backup data saves memory space but appending new data provides more safety. 

As for when to make backups, you can select “Later” to schedule a regular backup. That is, you can set the 
computer to perform a backup automatically at the same time every day. Since you can schedule backups in 
many different ways, for example, “every xx days,” “every Wednesday,” “at next login time” or “when the 
computer is idle,” you can choose the backup method that suits your way of using your computer. 
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1.5 Purchasing Your Own Computer 
PCs are becoming increasingly affordable. You can acquire a notebook PC and peripherals for less than 

100,000 yen. You may be planning to purchase a new PC as you enroll at university, or you may already have 
your own PC. Either way, you have to manage your PC by yourself. 

This section talks about how to choose a PC and other points to keep in mind doing so, Windows settings, and 
installing applications. 

Note that some Undergraduate Schools, Departments, and Majors purchase PCs as a group or specify which 
models students should purchase. Please check in advance. 

1.5.1 Selecting Hardware 

When you purchase a computer, choosing which one to buy is the most difficult decision. There is no general 
solution to this issue. Key points are the balance between your budget and machine performance, and product 
features such as appearance and user-friendliness. 

No matter what PC you consider, you have to take the following basic performance points into account. 
 
• Type of CPU and its clock speed 

• Amount of memory (RAM) 

• Hard disk drive capacity 

• Optical disks (for example, DVD) 

• Graphics and monitor 

• Network capability 

• OS 

The last item (OS) is software. If you purchase a PC these days, an OS is usually already installed on it (is 
“preinstalled”). The OS is an important criterion. 

Basically the point is “the bigger the better.” However, high-performance PCs are expensive. If you want to 
enjoy playing 3D games, you have to pay good money for all of these items. But if you only need a PC required 
for your time at university, an appropriate low-cost PC will do. 

Make sure the PC you buy has at least the following amounts of memory and hard disk drive capacity, optical 
disk, and network capability. 

It should have at least 1 GB of memory. Many PCs come standard with 512 MB memory. For most PCs, 512 
MB memory is sufficient. But for Windows Vista PCs, less than 1 GB memory may cause your computer to 
slow down or cause some functions to become disabled. 

A PC usually comes with adequate hard disk drive capacity, but considering you will use it for more than four 
years, it may be desirable to have at least a hard drive of at least 160 GB. Because of the increasing popularity of 
digital cameras and their increasing image resolutions, some pictures take up 3 MB or more each. Or you may 
want to load songs from music CDs and listen to them with a portable player. Both of these activities require a 
large capacity hard disk drive. 
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You need an optical disk drive for the installation of software, and for backup and recovery. An optical disk 
drive that can read and write DVD-Rs will be useful. 

A PC absolutely must have network capability. In addition to being able to connect to wired networks, it is 
desirable for a notebook PC to have Wi-Fi capability as well. 

From the authors’ personal viewpoint, you should give careful consideration to human interface factors, such 
as the display, keyboard and a mouse. It is painful to keep staring at a liquid crystal display that is not bright 
enough, and a good keyboard will directly improve your productivity (if your brain can keep up, that is). Before 
purchasing a product, be sure to try the model you are considering buying at a store to see how it feels. 

In addition to the details of your PC’s specification, you have to consider which type of PC to purchase: a 
notebook or a desktop. 

Notebook PCs can be divided into portable and non-portable PCs. If a PC is portable, it means the PC is 
relatively small and light, but remember that portability is only a relative concept (meaning whether or not you 
can carry around a 3 kg PC daily depends on who you are). Therefore, you have to try out the actual product 
before you buy it. Even if you will not carry it around, you should actually see and try out the product before you 
buy it anyway. 

One of the advantages of a notebook PC is that it has everything in one package. Its space-saving features 
suits housing in Japan. Since a relatively big notebook PC is also portable, you can carry it from your desk to a 
dining table or living room, or remove it from your desk if you are not using it. 

The disadvantages of a notebook PC include, in general, its smaller display area, a darker liquid crystal 
display, and a smaller memory and hard disk drive compared to a desktop PC. 

A desktop PC is used on a desk and is not moved. Although it takes up more space than a notebook PC, if you 
want to have the best computing environment, you must have a desktop PC. Moreover, you can add or upgrade 
the memory or hard disk drive of a desktop PC more easily than that of a notebook PC, and you can also freely 
choose the monitor, keyboard and mouse. 

However, since a desktop PC is not portable, you cannot take it to university. You need to have a USB flash 
drive or other media to carry data back and forth between university and your home. 

The prices of CPU and memory at a certain speed or capacity will doubtlessly fall over time. Therefore, the 
“reasonable” price of a PC with a certain specification will change over time. So it may be a good idea to 
compare various models over the Internet or by other means. 

Whether you choose a notebook PC or desktop PC, you are going to use a very expensive product for a long 
time, so your likes and dislikes also matter. So design, color and feel are also important. We repeat, as a rule you 
must actually see and touch the product before you buy it. 

1.5.2 Purchasing Software 

We tend to forget to include in our budget for a computer the purchasing of software. A computer needs 
software as well as hardware. Except for free software, you will need to purchase software in order to use your 
computer. 

Most of the application software discussed in this book is available for free, but a lot of popular application 
software needs to be purchased. 

If you do not want to spend a lot of money on software, it may be a good idea to try using free applications 
first, and purchase a commercially available equivalent only when free software cannot accomplish what you 
need to do. 

However, you should consider what you want to do with the PC when purchasing it. Therefore, if you need 
software for a certain purpose, you should include it in your PC purchase budget. 
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The most commonly-used software by general PC users is Microsoft Office. It is also called a productivity 
suite and is thought to be vital for office work. However, most of its functions can be replaced OpenOffice.org, 
which is free software. 

In addition to OpenOffice.org, there are many applications available for free. Free software is functionally 
inferior to commercial software in some cases, but in other cases, free software is better than commercial 
software. Even if free software is functionally inferior to commercial software, your mindset should be that you 
can improve your skills by devising ways to make up for the disadvantage. 

However, free software has certain restrictions. You cannot expect a level of support equivalent to that of 
commercial software (but commercial software does not necessarily have the best support), and it may require 
some trial and error. Free software demands you to strive to help yourself more than anything else, and that is its 
biggest difference from any commercial software. 

But times when you have problems provide the best opportunity to improve your PC skills. No one wants to 
encounter a problem, but once you have solved it, your skill will have definitely improved. 

1.5.3 Settings of Windows 

This section explains the settings you need in order to use Windows safely. 
The most important setting is the one that shows file extensions. The initial state of Windows hides extensions 

in file names, and users are supposed to guess the type of data from the file icons used. However, the icon which 
is used can be altered in a number of ways. In other words, the file you are about to double-click could be a virus 
that is using a Word file icon. 

To change the settings to show file extensions, click as follows: Start → Control Panel → Folder Options 
→ View tab → Advanced settings: 

 
• Under “Hidden files and folders,” select “Show hidden files and folders.” 

• Click to clear the “Hide extensions for known file types” check box. 

Click the Apply to All Folders button. The change to the settings has now been completed. 
 
Figure 1.27 “Program File with a Fake Folder Icon” shows an example. The figure on the left looks like it 

contains two folders, but if you look into the details, you will find that the icon on the right is actually a program 
masquerading as a folder. If the extension was hidden, you might have double-clicked the icon believing it was 
just a folder22. 

 

  

Figure 1.27: Program File with a Fake Folder Icon 

	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 
22 You students have a very bad habit of double-clicking every file for no reason at all. 
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You cannot tell from an extension alone what kind of data the file contains, and at times it is dangerous to 
check23. Anyway, you should follow the guidelines below when you handle files. 

 
• Trust files you have created. 

• Handle files with caution if they were sent from someone you trust or downloaded from an organization 
you trust. 

• Do not trust any other files. 

You should make a habit of starting Explorer by clicking Start → Programs → Accessories → Explorer, 
not by double-clicking My Documents or My Computer. By using Explorer, you can view the Windows File 
System on a routine basis and gain a deeper understanding of it. 

Also in the Folder Options dialog box, you should make the following settings as well. 
 
• Select the “Display the full path in the title bar” check box. 

• Select “Show hidden files and folders.” 

As above, after changing settings, click the Apply to All Folders button. 
However, in some windows, displaying all files and folders looks too crowded (for example, the My 

Documents folder of Windows Vista). In cases like this, change Folder Options only for the folders where you 
do not want all files and folders displayed. 

To be specific, open My Documents and select Folder Options on the Tools menu, and change the settings. 

1.5.4 Installing Applications 

Application software is generally copyrighted work. Therefore, you cannot use it without the author’s 
permission unless you are the person who created it. In particular, you cannot use commercial software unless 
you have purchased it. Here “purchase” means you have purchased the right to use it, not the right to copy and 
sell it (such a copy would be pirated software). You can purchase such commercial software from a store. 
Usually the package contains a CD-ROM or a DVD-ROM with the software on it and an installation manual. 
Follow the manual in order to install the software on your PC. 

On the other hand, a new view on copyright has emerged. Some types of software, free software24 and open 
source software25, can be used freely without cost. 

Such software may be sold at a store or can be obtained from a CD-ROM accompanying a magazine. 
However, probably the easiest way to obtain such software now is by downloading it using a Web browser. 

This section explains how to install applications software discussed in this textbook, such as OpenOffice.org. 
You are going to download free software and run it on a computer, but you should not get used to doing this. 

	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 
23 Unless you use special software, it is difficult to know the content of a file without opening it. 
24 Refer to http://www.fsf.org/. As this page says, “Free software is a matter of liberty not price.” What is important is freedom of using software and the 

various benefits obtained from it. It is not essential that it be free of charge. 
25 Refer to http://www.opensource.org/. Its concept is similar to that of free software, but slightly different. 
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Is there any guarantee that the software is not a virus or Trojan horse? The most important point of ensuring 
computer security is not to run any applications you cannot trust, and the most common cause for information 
disclosure, which is in the news these days, is thoughtless downloading from the Internet and double-clicking. 

It is not possible to eliminate all risks completely. But nonetheless be extremely careful when downloading 
software. 

Let us download the OpenOffice.org installer26. On the web page of OpenOffice.org Japanese Language 
Project (http://ja.openoffice.org/), click ダウンロード  (Download) and choose the OS you are 
using. Download for “JRE付き (with JRE)” Windows here. After the download is completed, double-click the 
file to start installation. 

The method of using the software is explained briefly on the web page of OpenOffice.org Japan Users Group 
(oooug.jp). Visit the page for more information. 

	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 	
 
26 A program for installation which contains the program itself and related files. 


